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DA 98-1787
September 4, 1998

AUCTION OF PHASE II 220 MHZ SERVICE LICENSES

54 Qualified Bidders

Report No. AUC-18-D (Auction No. 18)

This Public Notice identifies the 54 applicants that have been found qualified to bid in Auction
No. 18 for 908 Phase II 220 MHz Service licenses, which is scheduled to begin on Tuesday,
September 15, 1998.  This Public Notice contains bidding instructions and other important
information regarding the auction.  

Attachment A lists each of the 54 qualified bidders, their upfront payment and maximum eligibility
in bidding units.

Attachment B lists the licenses that were listed on each qualified bidder's FCC Form 175. 

Attachment C lists those applicants that submitted FCC Form 175 applications, but did not qualify
to bid in this auction.

Attachment D is a corrected version of the FCC Remote Bidding System Hardware and Software
Requirements (Attachment F of the Status of Applications Public Notice ).1

Attachment E has software downloading/installing instructions for participation in the mock
auction.

Attachment F has round results file formats for use during the auction.
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Attachment G has instructions for accessing the FCC Network using Windows 95.

Attachment H has instructions for accessing the FCC Network using Windows 3.1x.  

In order to participate effectively in the auction, qualified bidders should re-familiarize themselves
with the auction rules and other information contained in the Bidder Information Package and the
Public Notices released for this auction.   The following information provides additional guidance.2

Registration.  Qualified bidders have been automatically registered for the auction.  For security
reasons, the Commission will confirm registration by two separate mailings of registration
materials, both sent to the contact person at the address identified in the bidder's FCC Form 175. 
The two mailings will include the Bidder Identification Number, Login ID, Login Password and
the FCC Account Number.  The second mailing will include the remote bidding system software,
if ordered.  Upon receipt of both mailings, each bidder should be in possession of the following
information:

   ! FCC Account Number (as assigned by FCC)
   ! Bidder Identification Number (supplied by FCC mailing)
   ! Login ID (supplied by FCC mailing)
   ! Login Password (supplied by FCC mailing)
   ! Remote bidding system software, if ordered (supplied by FCC mailing)

It is each applicant's responsibility to ensure the security of their bidding codes and to
ensure that only authorized bidders place bids on their behalf.  Applicants are solely
responsible for ensuring the security of their computer systems, the security of their
bidding codes, and that only authorized bidders place bids on their behalf.  The FCC
assumes no responsibility or liability for these matters.
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WARNING:  Any unauthorized person or entity accessing or tampering with an FCC or
other government computer will be prosecuted to the full extent of the law.  

Any applicant listed as a qualified bidder in Attachment A to this Public Notice that has not
received both registration mailings by noon on Thursday, September 10, 1998, should contact
the FCC at (888) CALL-FCC ((888) 225-5322).  Callers should press option number 2 at the
prompt for auction inquiries, and ask to speak to Kathy Garland.  It is each applicant's
responsibility to ensure that all registration information has been received on time.

Lost Login IDs, Login Passwords and Bidder Identification Numbers can be replaced only at the
FCC Auction Headquarters, located at 2 Massachusetts Avenue, N.E., Washington, D.C.  If
replacement is necessary, either an authorized representative or the certifying official (as
designated on the applicant's FCC Form 175) must appear in person with two forms of
identification, one of which must be a photo identification.

Electronic Bidding Software.  In order to bid electronically, each qualified bidder that filed its
FCC Form 175 electronically must purchase the Commission's electronic bidding software.  The
software has been updated for the Phase II 220 MHz Service auction.  Bidders are advised to
review the software manual included in the registration materials and participate in the mock
auction to become familiar with this software.  For software backup, bidders are advised to
duplicate the software for use by authorized representatives at different locations.  However, the
FCC Remote Bidding System will not accept electronic bids from qualified bidders that are not
registered purchasers of the bidding software.

Bidding Contingency Plan.  Bidders should develop comprehensive contingency plans they can
implement quickly in case they experience difficulty participating in the auction.  While the FCC
will correct any problems within Commission-controlled facilities, bidders are solely responsible
for anticipating and overcoming problems such as bidder technical failures, local telephone service
interruptions, adverse local weather conditions, unavailability of authorized bidders, or loss or
breach of confidential security codes. 

The FCC Remote Bidding System requires access to a 900 service telephone line.  Bidders should
verify in advance that the telephone systems they will be using to submit electronic bids permit
access to 900 service telephone numbers, and should consult their telephone administrators if they
need assistance.

All filers, manual and electronic, will be supplied with a telephone number for telephonic bidding
in their registration packet.  This number can also be used by electronic bidders as an alternate
method of bidding in the event they are not able to submit their bids electronically.

Bidding Schedule.  The bidding schedule for Tuesday, September 15, 1998 will be:

Bidding Period  9:00 a.m. - 11:00 a.m.  ET
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Round Results 11:00 a.m. - 11:30 a.m.  ET

The bidding schedule for Wednesday, September 16, 1998 to Friday, September 18, 1998 will be:

Bidding Period  9:00 a.m. - 10:00 a.m. ET
Round Results 10:00 a.m. - 10:30 a.m. ET

Bidding Period 2:00 p.m. - 3:00 p.m.  ET
Round Results 3:00 p.m. - 3:30 p.m.  ET

The FCC will set the pace of the auction based upon its monitoring of the bidding and its
assessment of the auction's progress.  Generally, at the end of each week of the auction, the FCC
will announce the bidding schedule for the following week.

Minimum Opening Bids.  There will be a minimum opening bid for each license in the Phase II
220 MHz Service auction, calculated in accordance with the formulas we have previously
announced.  See Auction Notice and Filing Requirements Public Notice at 24-29.  The minimum
opening bid amount is subject to reduction at the discretion of the Commission.  Bidders should
be aware, however, that the FCC will not entertain requests to lower minimum opening bids.  The
agency will exercise its discretion, if at all, independent of any communications from bidders.

Messages and Announcements.  The FCC will post pertinent auction information as messages
and announcements on the FCC Remote Bidding System, on its Internet site and on its Bulletin
Board System (BBS).  Bidders should routinely check for messages and announcements each time
they enter the Remote Bidding System, and should read this information carefully.

Bidder Questions during the Auction.  FCC auction officials and technical support staff will be
available during the course of the auction to answer questions from bidders.  Bidders should
identify themselves as a bidder with time sensitive auction questions when calling any number. 
Help can be obtained through the following telephone numbers:

FCC Bidder Line Use telephonic bid number 
(telephonic bidding, auction conduct supplied in registration mailing
questions)

FCC Technical Support Hotline (202) 414-1250
(all technical questions, software and
hardware)

FCC Auctions Division (202) 418-0660
(legal questions)
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Monitoring Round Results.  Attachment F to this Public Notice provides instructions for
reviewing and downloading round results, and other material related to the Phase II 220 MHz
Service auction released by the Commission during the course of the auction.

Auction Tracking Tool.  A software tool for tracking the progress of the auction will be made
available on Thursday, September 10, 1998 via the Internet at
http://www.fcc.gov/wtb/auctions/220 and the FCC Auctions Bulletin Board System.
Bidders wishing to familiarize themselves with the tracking tool software are encouraged to try
the tracking tool software for the previously-held LMDS auction at
http://www.fcc.gov/wtb/auctions/lmds.  In addition to the LMDS software, the Bureau is
providing a software application that may be used during the 220 mock auction to familiarize
bidders with the tracking tool.  It will be located at http://www.fcc.gov/wtb/auctions/220 and will
be available on Wednesday, September 9, 1998.  (Please note:  This tool is not for use during the
Phase II 220 MHz Service auction but has similar functionality and provides a useful tool for
practice before and during the 220 Mock Auction.)

The tracking tool is a Microsoft Excel™ v5.0 WorkBook, which runs on Microsoft Windows™
v3.1, Windows for WorkGroups™ v3.11, and Windows 95.  With this auction tracking tool,
bidders can import round results and analyze the bidding in the auction.  Technical support for the
tracking tool can be obtained by calling the FCC Technical Support Hotline.  Please review the
information included with the tracking tool README file thoroughly before calling technical
support.

User Requirements. This software is not designed for novice computer users. To be used
effectively, you must have extensive experience with:
* Microsoft Windows
* Microsoft Excel v5.0
* the FCC simultaneous multiple-round auction format

Software and Hardware Requirements. At a minimum, you will need the following:
* Microsoft Windows v3.1+, Windows for WorkGroups 3.11 or Windows 95
* Microsoft Excel v5.0 or later
* 8MB of available hard disk space
* 16MB of RAM and a Pentium™ based processor are highly recommended

Amendments to FCC Form 175s.  Applicants are responsible for the continuing accuracy and
completeness of information furnished in their FCC Form 175 and its exhibits. See 47 C.F.R §
1.65.  It is the staff's position that applicants should amend their applications within ten business
days from the occurrence of a reportable change.  Filers should make modifications to their FCC
Form 175s electronically, and submit a letter briefly summarizing the changes to:

Amy Zoslov
Chief, Auctions & Industry Analysis Division
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Wireless Telecommunications Bureau
Federal Communications Commission

Washington, D.C. 20554

with a courtesy copy to Frank Stilwell and Christina Clearwater at the same address.

As described in the Commission's Rules, applicants may make only minor corrections to their FCC
Form 175 applications; major modifications (e.g., changing the markets applied for, changing
control of the applicant, changing the certifying official or signing a manual application) will not
be accepted.  See 47 C.F.R. § 1.2105(b).

Due Diligence.  Bidders are reminded that they should continue to conduct due diligence
examinations regarding incumbents and other legal developments with respect to the licenses for
which they bid during the course of the auction.  As we have previously explained, while the
Commission will continue to act on pending applications, requests, and petitions, some of these
matters may not be resolved prior to the start of the auction.  3

Mock Auction.  The FCC will conduct a mock auction on Friday, September 11, 1998, to allow
bidders to familiarize themselves with the electronic bidding software and the new bidding
procedures.  Telephonic bidding will also be available during the mock auction.  Participants
wishing to place telephonic bids should use the telephone number supplied in the registration
materials for the auction.  The mock auction will be open only to qualified bidders.  Pre-
registration is not required to participate in the mock auction.  

This mock auction will include all 908 Phase II 220 MHz Service licenses, and will follow the
rules governing the Phase II 220 MHz Service auction.  The mock auction will be identified as
Auction No. 74.  The program will assume that each bidder applied for all 908 licenses and
submitted upfront payments of $1,000,000, corresponding to 1,000,000 bidding units.  The
auction will simulate the start of Stage One, so bidders will be required to be active on at least 80
percent of their bidding units, or risk having a waiver automatically applied unless bidding
eligibility is reduced.

The mock auction bidding schedule for Friday, September 11, 1998 will be:

Round 1
Bidding Period   9:00 a.m. - 10:00 a.m. ET
Round Results  10:00 a.m. - 10:30 a.m. ET

Round 2
Bidding Period 10:30 a.m. - 11:30 a.m. ET
Round Results 11:30 a.m.  - 12:00 p.m. ET
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Lunch 12:00 p.m. - 1:00 p.m. ET

Round 3
Bidding  Period 1:00 p.m. - 1:30 p.m. ET
Round Results 1:30 p.m. - 2:00 p.m. ET

Round 4
Bidding  Period 2:00 p.m. - 2:30 p.m. ET
Round Results 2:30 p.m. - 3:00 p.m. ET

Round 5
Bidding  Period 3:00 p.m. - 3:30 p.m. ET
Round Results 3:30 p.m. - 4:00 p.m. ET

Round 6
Bidding  Period 4:00 p.m. - 4:30 p.m. ET
Round Results 4:30 p.m. - 5:00 p.m. ET

Eligible Phase II 220 MHz Service bidders who wish to participate in the mock auction using
electronic bidding must establish a PPP connection to the FCC Auction Network through either
an 800 or a 900 number, as selected through the mock auction software.  (The FCC strongly
encourages participants to test their ability to connect using the 900 number, in order to identify
any potential problems such as a 900-number telephone block.  There will be no access charge for
the first minute of the 900-number connection time.)

When participants establish the PPP connection and start the Mock Bidding System, they will
register for the mock auction by entering their FCC Account Number.  The Login names, Login
passwords, and Bidder Identification Numbers (BINs) will be pre-filled.  Note:  Pre-filled codes
are for the mock auction only.  For the actual Phase II 220 MHz Service auction, valid login
codes and BINs will be mailed to qualified bidders with their registration materials.

Remote bidding software for the mock auction will be available via the FCC's Internet and
Bulletin Board System beginning Wednesday, September 9, 1998.  See Attachment E for
downloading/installing instructions.  This software is specifically designed for this simulation, and
is not adaptable to any other FCC spectrum auction.  As part of the software, the Commission has
established a suggestion box and welcomes your comments regarding the software.

OTHER IMPORTANT INFORMATION

Long-Form Applications:  Applicants that claim status as a small or very small business should
be aware that at the long-form application stage, they will be subject to the more extensive
reporting requirements contained in the newly adopted Part 1 ownership disclosure rule.  See 47
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C.F.R. § 1.2112(b).  Also, applicants with foreign ownership interests will be required to comply
with § 310(b)(4) at the long-form application stage.  

For additional information regarding this Public Notice, please contact Lisa Hartigan, Frank
Stilwell or Christina Clearwater, Auctions & Industry Analysis Division, Wireless
Telecommunications Bureau, at (202) 418-0660.  Questions about software or hardware should
be directed to Technical Support at (202) 414-1250.  



ATTACHMENT A
FCC Phase II 220 MHz Service Auction
Auction ID:18
Qualified Bidders - Public Notice

(Sorted by Applicant)
Date of Report:9/3/98
The following Applicants have been found 'Qualified':

FCC Account # Name Upfront Payment
Maximum Eligibility
     (Bid - Units)

0181138215 220 MHz Bidding Consortium $309,000.00 309,000

0181549103 Active Communications, Inc. $2,500.00 2,500

0181519536 AreaWide Communications Inc. $12,500.00 12,500

0181634126 Berkeley Electric Co-op, Inc. $60,000.00 60,000

0181058312 Carolina Wireless Dispatch, Inc. $50,000.00 50,000

0181148067 Com/Rad Inc. $15,000.00 15,000

0181013387 Communications Specialists, Inc. $12,500.00 12,500

0181615276 Comtech, Inc. $12,500.00 12,500

0181507562 Comtran Associates Inc. $23,920.00 23,920

0182251135 DeltaCom, Inc. $27,382.00 27,382

0181352564 Dispatch & Data of Ohio, Inc. $9,130.00 9,130

0181613065 FM Communications, Inc. $2,500.00 2,500

0181426388 FleetTalk Partners Ltd. $10,338.00 10,338

0181525028 Garnette Communications o/o David G Boyle $5,000.00 5,000

0181317057 Georgia 220 MHZ Alliance, LLC $18,000.00 18,000

0181850404 Gulf Coast Electronics, Inc. $5,000.00 5,000

0181439209 Herbert J. Schock & Nancy J. Douglas $7,500.00 7,500

0181648029 Intek License Acquisition Corp. $3,500,000.00 3,500,000

0181218170 Intellicom Bidding Consortium $152,000.00 152,000

0181721031 J & C Joint Venture $300,000.00 300,000

0182341493 Jeremy Greene $28,926.00 28,926

0181850341 KDR, INC. $55,000.00 55,000

0181140285 Knox LaRue, Sr. $13,034.00 13,034

0181636531 Longhorn Communications Incorporated $200,000.00 200,000

0181727483 MOBILE COMMUNICATIONS SERVICE OF MIAMI, INC. $9,078.00 9,078

0181822305 Millenium 2000, Inc. $5,000.00 5,000

0181739307 Mountain Message & Pager Service, Inc. $5,532.00 5,532

0181507149 Nancy J. Douglas $5,000.00 5,000

0182307122 Net Radio Group Communications, LLC $640,000.00 640,000

0180923507 Nextel 220 License Acquisition Corp. $5,254,736.00 5,254,736

Page 1 of 2



ATTACHMENT A
FCC Phase II 220 MHz Service Auction
Auction ID:18
Qualified Bidders - Public Notice

(Sorted by Applicant)
Date of Report:9/3/98
The following Applicants have been found 'Qualified':

FCC Account # Name Upfront Payment
Maximum Eligibility
     (Bid - Units)

0181454022 Oliver M. Collins $13,097.00 13,097

0181624195 Philip Adler $233,498.00 233,498

0182042583 Philip J Schrader $5,000.00 5,000

0181429251 RADIO COMM SERVICES INC. $13,032.00 13,032

0181647258 Raleigh Radio-Data SMR Operating Partnership $20,000.00 20,000

0181342234 Repeater Network Spectrum Aq., Inc. $325,000.00 325,000

0181612079 Rush Network Corp. $400,000.00 400,000

0181227013 S. K. Warren Communications, Inc. $100,000.00 100,000

0182144368 SOPHIA Licensee, Inc. $1,000,000.00 1,000,000

0181312171 Sarina L. Gibbs $7,455.00 7,455

0181704009 Savoy Communications Inc. $100,000.00 100,000

0180929273 Shell Offshore Services Company $64,500.00 64,500

0181727438 Supreme Radio Communications, Inc. $25,000.00 25,000

0181314379 TAMPA BAY COMMUNICATIONS INC. $16,124.00 16,124

0181713257 TELELINK, INC. $7,500.00 7,500

0181534589 The Champaign Telephone Company $12,500.00 12,500

0181728408 Triangle Communications, Inc. $14,400.00 14,400

0181813298 Tuchman & Brown Investment Inc. No.2 $5,000.00 5,000

0181836016 Two-Twenty Auction Company, Inc. $1,602,055.00 1,602,055

0181609278 US MobilComm, Inc. $200,000.00 200,000

0181309014 Winsome Inc. $2,500.00 2,500

0181315063 Wireless Communication Technologies Inc. $22,230.00 22,230

0181507351 Wireless Services, Inc. $2,500.00 2,500

0180915207 cellutech $5,000.00 5,000

Page 2 of 2



Attachment B
FCC Phase II 220 MHz Service Auction
Auction ID:18
Qualified Bidders - Public Notice

(Sorted by Applicant)
Date of Report:   9/4/98
The following Applicants have been found 'Qualifed':

FCC Account # Name Waiver Requested

0181138215 220 MHz Bidding Consortium

The following License(s):

ALL

0181549103 Active Communications, Inc.

The following License(s):

BEA001-A BEA002-A BEA002-B BEA002-C BEA002-D BEA002-E EAG001-F EAG001-G EAG001-H EAG001-I

0181519536 AreaWide Communications Inc.

The following License(s):

ALL

0181634126 Berkeley Electric Co-op, Inc.

The following License(s):

BEA023-A BEA023-B BEA023-C BEA023-D BEA023-E BEA024-A BEA024-B BEA024-C BEA024-D BEA024-E BEA025-A

BEA025-B BEA025-C BEA025-D BEA025-E BEA026-A BEA026-B BEA026-C BEA026-D BEA026-E BEA027-A BEA027-B

BEA027-C BEA027-D BEA027-E BEA028-A BEA028-B BEA028-C BEA028-D BEA028-E BEA041-A BEA041-B BEA041-C

BEA041-D BEA041-E

0181058312 Carolina Wireless Dispatch, Inc.

The following License(s):

ALL

0180915207 cellutech

The following License(s):

ALL

0181148067 Com/Rad Inc.

The following License(s):

ALL

0181013387 Communications Specialists, Inc.

The following License(s):

BEA058-A BEA058-B BEA058-C BEA058-D BEA058-E BEA062-A BEA062-B BEA062-C BEA062-D BEA062-E BEA065-A

BEA065-B BEA065-C BEA065-D BEA065-E

0181615276 Comtech, Inc.

The following License(s):

BEA051-A BEA051-B BEA051-C BEA051-D BEA051-E

0181507562 Comtran Associates Inc.

The following License(s):

BEA010-A BEA010-B BEA010-C BEA010-D BEA010-E

0182251135 DeltaCom, Inc.

The following License(s):

BEA057-A BEA057-B BEA057-C BEA057-D BEA057-E BEA058-A BEA058-B BEA058-C BEA058-D BEA058-E BEA059-A
Page 1 of 7



Attachment B
FCC Phase II 220 MHz Service Auction
Auction ID:18
Qualified Bidders - Public Notice

(Sorted by Applicant)
Date of Report:   9/4/98
The following Applicants have been found 'Qualifed':

FCC Account # Name Waiver Requested

BEA059-B BEA059-C BEA059-D BEA059-E BEA061-A BEA061-B BEA061-C BEA061-D BEA061-E BEA062-A BEA062-B

BEA062-C BEA062-D BEA062-E BEA065-A BEA065-B BEA065-C BEA065-D BEA065-E

0181352564 Dispatch & Data of Ohio, Inc.

The following License(s):

BEA055-A BEA055-B BEA055-C BEA055-D BEA055-E

0181426388 FleetTalk Partners Ltd.

The following License(s):

BEA170-A BEA170-B BEA170-D

0181613065 FM Communications, Inc.

The following License(s):

BEA007-A BEA007-B BEA007-C BEA007-D BEA007-E BEA008-A BEA008-B BEA008-C BEA008-D BEA008-E

0181525028 Garnette Communications o/o David G Boyle

The following License(s):

BEA118-A BEA118-B BEA118-C BEA118-D BEA118-E BEA128-A BEA128-B BEA128-C BEA128-D BEA128-E BEA129-A

BEA129-B BEA129-C BEA129-D BEA129-E

0181317057 Georgia 220 MHZ Alliance, LLC

The following License(s):

ALL

0181850404 Gulf Coast Electronics, Inc.

The following License(s):

BEA085-A BEA085-B BEA085-C BEA085-D BEA085-E BEA086-A BEA086-B BEA086-C BEA086-D BEA086-E BEA087-A

BEA087-B BEA087-C BEA087-D BEA087-E

0181439209 Herbert J. Schock & Nancy J. Douglas

The following License(s):

BEA071-A BEA071-B BEA071-C

0181648029 Intek License Acquisition Corp.

The following License(s):

ALL

Page 2 of 7



Attachment B
FCC Phase II 220 MHz Service Auction
Auction ID:18
Qualified Bidders - Public Notice

(Sorted by Applicant)
Date of Report:   9/4/98
The following Applicants have been found 'Qualifed':

FCC Account # Name Waiver Requested

0181218170 Intellicom Bidding Consortium

The following License(s):

BEA001-A BEA001-B BEA001-C BEA001-D BEA001-E BEA002-A BEA002-B BEA002-C BEA002-D BEA002-E BEA003-A

BEA003-B BEA003-C BEA003-D BEA003-E BEA004-A BEA004-B BEA004-C BEA004-D BEA004-E BEA005-A BEA005-B

BEA005-C BEA005-D BEA005-E BEA006-A BEA006-B BEA006-C BEA006-D BEA006-E BEA007-A BEA007-B BEA007-C

BEA007-D BEA007-E BEA008-A BEA008-B BEA008-C BEA008-D BEA008-E BEA009-A BEA009-B BEA009-C BEA009-D

BEA009-E BEA010-A BEA010-B BEA010-C BEA010-D BEA010-E BEA011-A BEA011-B BEA011-C BEA011-D BEA011-E

BEA012-A BEA012-B BEA012-C BEA012-D BEA012-E BEA013-A BEA013-B BEA013-C BEA013-D BEA013-E BEA015-A

BEA015-B BEA015-C BEA015-D BEA015-E BEA018-A BEA018-B BEA018-C BEA018-D BEA018-E BEA019-A BEA019-B

BEA019-C BEA019-D BEA019-E BEA020-A BEA020-B BEA020-C BEA020-D BEA020-E BEA021-A BEA021-B BEA021-C

BEA021-D BEA021-E BEA022-A BEA022-B BEA022-C BEA022-D BEA022-E BEA023-A BEA023-B BEA023-C BEA023-D

BEA023-E BEA024-A BEA024-B BEA024-C BEA024-D BEA024-E BEA040-A BEA040-B BEA040-C BEA040-D BEA040-E

BEA041-A BEA041-B BEA041-C BEA041-D BEA041-E BEA047-A BEA047-B BEA047-C BEA047-D BEA047-E BEA048-A

BEA048-B BEA048-C BEA048-D BEA048-E BEA049-A BEA049-B BEA049-C BEA049-D BEA049-E BEA050-A BEA050-B

BEA050-C BEA050-D BEA050-E BEA051-A BEA051-B BEA051-C BEA051-D BEA051-E BEA053-A BEA053-B BEA053-C

BEA053-D BEA053-E BEA054-A BEA054-B BEA054-C BEA054-D BEA054-E BEA055-A BEA055-B BEA055-C BEA055-D

BEA055-E BEA056-A BEA056-B BEA056-C BEA056-D BEA056-E EAG001-F EAG001-G EAG001-H EAG001-I EAG001-J

EAG002-F EAG002-G EAG002-H EAG002-I EAG002-J

0181721031 J & C Joint Venture

The following License(s):

ALL

0182341493 Jeremy Greene

The following License(s):

BEA160-E BEA161-E BEA162-E BEA163-E

0181850341 KDR, INC.

The following License(s):

ALL

0181140285 Knox LaRue, Sr.

The following License(s):

BEA162-A BEA162-B BEA162-C BEA162-D BEA162-E BEA163-A BEA163-B BEA163-C BEA163-D BEA163-E BEA164-A

BEA164-B BEA164-C BEA164-D BEA164-E

0181636531 Longhorn Communications Incorporated

The following License(s):

ALL

0181822305 Millenium 2000, Inc.
The following License(s):

BEA015-A BEA015-B BEA015-C BEA015-D BEA015-E BEA016-A BEA016-B BEA016-C BEA016-D BEA016-E

0181727483 MOBILE COMMUNICATIONS SERVICE OF MIAMI, INC.

The following License(s):
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Attachment B
FCC Phase II 220 MHz Service Auction
Auction ID:18
Qualified Bidders - Public Notice

(Sorted by Applicant)
Date of Report:   9/4/98
The following Applicants have been found 'Qualifed':

FCC Account # Name Waiver Requested

BEA031-A BEA031-B BEA031-C BEA031-D BEA031-E

0181739307 Mountain Message & Pager Service, Inc.

The following License(s):

BEA141-A BEA141-B BEA141-C BEA141-D BEA141-E BEA152-A BEA152-B BEA152-C BEA152-D BEA152-E

0181507149 Nancy J. Douglas

The following License(s):

BEA158-A BEA158-B

0182307122 Net Radio Group Communications, LLC

The following License(s):

ALL

0180923507 Nextel 220 License Acquisition Corp.

The following License(s):

ALL

0181454022 Oliver M. Collins

The following License(s):

ALL

0181624195 Philip Adler

The following License(s):

ALL A

ALL B

ALL C

ALL D

ALL E

ALL F

ALL G

ALL H

ALL I

ALL J

0182042583 Philip J Schrader

The following License(s):

ALL

0181429251 RADIO COMM SERVICES INC.

The following License(s):

ALL

0181647258 Raleigh Radio-Data SMR Operating Partnership

The following License(s):

ALL

0181342234 Repeater Network Spectrum Aq., Inc.
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Attachment B
FCC Phase II 220 MHz Service Auction
Auction ID:18
Qualified Bidders - Public Notice

(Sorted by Applicant)
Date of Report:   9/4/98
The following Applicants have been found 'Qualifed':

FCC Account # Name Waiver Requested

The following License(s):

ALL

181612079 Rush Network Corp.

The following License(s):

ALL

0181227013 S. K. Warren Communications, Inc.

The following License(s):

ALL

0181312171 Sarina L. Gibbs

The following License(s):

BEA013-A

0181704009 Savoy Communications Inc.

The following License(s):

ALL

0180929273 Shell Offshore Services Company

The following License(s):

ALL

0182144368 SOPHIA Licensee, Inc.

The following License(s):

ALL

0181727438 Supreme Radio Communications, Inc.

The following License(s):

BEA101-A BEA101-B BEA101-C BEA101-D BEA101-E BEA102-A BEA102-B BEA102-C BEA102-D BEA102-E

0181314379 TAMPA BAY COMMUNICATIONS INC.

The following License(s):

BEA034-A BEA034-B BEA034-C BEA034-D BEA034-E BEA174-A

0181713257 TELELINK, INC.

The following License(s):

BEA083-C BEA084-C BEA085-C
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Attachment B
FCC Phase II 220 MHz Service Auction
Auction ID:18
Qualified Bidders - Public Notice

(Sorted by Applicant)
Date of Report:   9/4/98
The following Applicants have been found 'Qualifed':

FCC Account # Name Waiver Requested

0181534589 The Champaign Telephone Company

The following License(s):

BEA001-A BEA001-B BEA001-C BEA001-D BEA001-E BEA002-A BEA002-B BEA002-C BEA002-D BEA002-E BEA003-A

BEA003-B BEA003-C BEA003-D BEA003-E BEA004-A BEA004-B BEA004-C BEA004-D BEA004-E BEA005-A BEA005-B

BEA005-C BEA005-D BEA005-E BEA006-A BEA006-B BEA006-C BEA006-D BEA006-E BEA007-A BEA007-B BEA007-C

BEA007-D BEA007-E BEA008-A BEA008-B BEA008-C BEA008-D BEA008-E BEA009-A BEA009-B BEA009-C BEA009-D

BEA009-E BEA010-A BEA010-B BEA010-C BEA010-D BEA010-E BEA011-A BEA011-B BEA011-C BEA011-D BEA011-E

BEA012-A BEA012-B BEA012-C BEA012-D BEA012-E BEA013-A BEA013-B BEA013-C BEA013-D BEA013-E BEA014-A

BEA014-B BEA014-C BEA014-D BEA014-E BEA015-A BEA015-B BEA015-C BEA015-D BEA015-E BEA016-A BEA016-B

BEA016-C BEA016-D BEA016-E BEA017-A BEA017-B BEA017-C BEA017-D BEA017-E BEA018-A BEA018-B BEA018-C

BEA018-D BEA018-E BEA019-A BEA019-B BEA019-C BEA019-D BEA019-E BEA020-A BEA020-B BEA020-C BEA020-D

BEA020-E BEA021-A BEA021-B BEA021-C BEA021-D BEA021-E BEA022-A BEA022-B BEA022-C BEA022-D BEA022-E

BEA023-A BEA023-B BEA023-C BEA023-D BEA023-E BEA024-A BEA024-B BEA024-C BEA024-D BEA024-E BEA025-A

BEA025-B BEA025-C BEA025-D BEA025-E BEA026-A BEA026-B BEA026-C BEA026-D BEA026-E BEA027-A BEA027-B

BEA027-C BEA027-D BEA027-E BEA028-A BEA028-B BEA028-C BEA028-D BEA028-E BEA029-A BEA029-B BEA029-C

BEA029-D BEA029-E BEA030-A BEA030-B BEA030-C BEA030-D BEA030-E BEA031-A BEA031-B BEA031-C BEA031-D

BEA031-E BEA032-A BEA032-B BEA032-C BEA032-D BEA032-E BEA033-A BEA033-B BEA033-C BEA033-D BEA033-E

BEA034-A BEA034-B BEA034-C BEA034-D BEA034-E BEA035-A BEA035-B BEA035-C BEA035-D BEA035-E BEA036-A

BEA036-B BEA036-C BEA036-D BEA036-E BEA037-A BEA037-B BEA037-C BEA037-D BEA037-E BEA038-A BEA038-B

BEA038-C BEA038-D BEA038-E BEA039-A BEA039-B BEA039-C BEA039-D BEA039-E BEA040-A BEA040-B BEA040-C

BEA040-D BEA040-E BEA041-A BEA041-B BEA041-C BEA041-D BEA041-E BEA042-A BEA042-B BEA042-C BEA042-D

BEA042-E BEA043-A BEA043-B BEA043-C BEA043-D BEA043-E BEA044-A BEA044-B BEA044-C BEA044-D BEA044-E

BEA045-A BEA045-B BEA045-C BEA045-D BEA045-E BEA046-A BEA046-B BEA046-C BEA046-D BEA046-E BEA047-A

BEA047-B BEA047-C BEA047-D BEA047-E BEA048-A BEA048-B BEA048-C BEA048-D BEA048-E BEA049-A BEA049-B

BEA049-C BEA049-D BEA049-E BEA050-A BEA050-B BEA050-C BEA050-D BEA050-E BEA051-A BEA051-B BEA051-C

BEA051-D BEA051-E BEA052-A BEA052-B BEA052-C BEA052-D BEA052-E BEA053-A BEA053-B BEA053-C BEA053-D

BEA053-E BEA054-A BEA054-B BEA054-C BEA054-D BEA054-E BEA055-A BEA055-B BEA055-C BEA055-D BEA055-E

BEA056-A BEA056-B BEA056-C BEA056-D BEA056-E BEA057-A BEA057-B BEA057-C BEA057-D BEA057-E BEA058-A

BEA058-B BEA058-C BEA058-D BEA058-E BEA059-A BEA059-B BEA059-C BEA059-D BEA059-E BEA060-A BEA060-B

BEA060-C BEA060-D BEA060-E BEA061-A BEA061-B BEA061-C BEA061-D BEA061-E BEA062-A BEA062-B BEA062-C

BEA062-D BEA062-E BEA063-A BEA063-B BEA063-C BEA063-D BEA063-E BEA064-A BEA064-B BEA064-C BEA064-D

BEA064-E BEA065-A BEA065-B BEA065-C BEA065-D BEA065-E BEA066-A BEA066-B BEA066-C BEA066-D BEA066-E

BEA067-A BEA067-B BEA067-C BEA067-D BEA067-E BEA068-A BEA068-B BEA068-C BEA068-D BEA068-E BEA069-A

BEA069-B BEA069-C BEA069-D BEA069-E BEA070-A BEA070-B BEA070-C BEA070-D BEA070-E BEA071-A BEA071-B

BEA071-C BEA071-D BEA071-E BEA072-A BEA072-B BEA072-C BEA072-D BEA072-E BEA073-A BEA073-B BEA073-C

BEA073-D BEA073-E BEA074-A BEA074-B BEA074-C BEA074-D BEA074-E BEA075-A BEA075-B BEA075-C BEA075-D

BEA075-E BEA076-A BEA076-B BEA076-C BEA076-D BEA076-E BEA077-A BEA077-B BEA077-C BEA077-D BEA077-E

BEA078-A BEA078-B BEA078-C BEA078-D BEA078-E BEA079-A BEA079-B BEA079-C BEA079-D BEA079-E BEA080-A

BEA080-B BEA080-C BEA080-D BEA080-E BEA081-A BEA081-B BEA081-C BEA081-D BEA081-E BEA082-A BEA082-B

BEA082-C BEA082-D BEA082-E

0181728408 Triangle Communications, Inc.

The following License(s):

ALL
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Attachment B
FCC Phase II 220 MHz Service Auction
Auction ID:18
Qualified Bidders - Public Notice

(Sorted by Applicant)
Date of Report:   9/4/98
The following Applicants have been found 'Qualifed':

FCC Account # Name Waiver Requested

0181813298 Tuchman & Brown Investment Inc. No.2

The following License(s):

BEA049-A BEA049-B BEA049-C BEA049-D BEA049-E

0181836016 Two-Twenty Auction Company, Inc.

The following License(s):

ALL

0181609278 US MobilComm, Inc.

The following License(s):

ALL

0181309014 Winsome Inc.

The following License(s):

BEA005-E BEA006-E BEA007-E BEA008-E BEA010-E BEA013-E BEA014-E

0181315063 Wireless Communication Technologies Inc.

The following License(s):

ALL

0181507351 Wireless Services, Inc.

The following License(s):

ALL
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ATTACHMENT C
FCC Phase II 220 MHz Service Auction  

Non-Qualified Bidders
Auction ID:18

(Sorted by Applicant)
Date of Report: 9/3/98

FCC Account # Name  

0181051294 Air Spectrum III, Inc.

0181327111 American Pacific Inc.

0181559584 BRANDON DESIGN AND CONSTRUCTON, INC.

0181406183 Bozcom Inc. dba B & B Tower Management

0181430242 CVTV, Inc.

0181600364 Communications Engineering Company

0181724218 FiberlessNet, Inc

0181623349 First Florida Communications, Inc.

0181606391 Gary Campbell

0181651182 Illinois Cooperative Assoc., Inc. dba Clear Talk

0181032448 MOBEX COMMUNICATIONS INC

0180823586 Mark Jendrek

0181909526 Metricom, Inc.

0181531035 Ralph Pierce Addington

0181519391 Silke Communications, Inc.

0181420377 T Group Communications

0181310363 Transworld Technologies Inc.

Page 1 of 1
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Attachment D

The following is a corrected version of the material that appeared in Attachment F of the Status of
Applications Public Notice with changes italicized.  Please note this version supersedes the prior
version.  

FCC Remote Bidding System Hardware and Software Requirements

You need at a minimum the following hardware and software:

C CPU: Intel® Pentium or above 

C RAM: 16 MB (more recommended if you have multiple applications open)

C Hard Disk: Windows 3.1: 12 MB available disk space 
Windows 95: 33 MB available disk space

C 1.44 MB Floppy Drive or CD-ROM Drive (to install the Remote Bidding System)

C Modem: v.32bis 14.4 kbps Hayes© compatible modem

C Monitor: VGA or above

C Mouse or other pointing device

C Microsoft® Windows™ 3.1, Windows for Workgroups™ 3.11, or Windows 95™

C Netscape® Communicator™ 4.05
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Attachment E

DOWNLOADING AND INSTALLING
 THE FCC MOCK BIDDING SYSTEM

This attachment describes how to download and install the FCC Mock Bidding System for
qualified bidders who wish to participate in the FCC Mock Auction.

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions
link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Location field, Selected Licenses
area of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions. 
For example, if you are instructed to type http://wtbwww01.fcc.gov, you should
type all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then
press the ENTER key.

Qualified bidders who want to participate in the FCC Mock Auction will need, at a minimum, the
following hardware and software:

Minimum Hardware Requirements

o CPU: Intel® Pentium
o RAM: 16 MB (more recommended if you have multiple applications open)
o Hard Disk:

Windows 3.1x: 12 MB available disk space 
Windows 95: 33 MB available disk space

o Modem: v.32bis 14.4 kbps Hayes© compatible mode
o Monitor: VGA or above
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o Mouse or other pointing device

To create optional backup installation disks for the FCC Mock Bidding System, you will need the
following:

o 1.44-MB 3.5" floppy drive 
o For Windows 95: Five blank MS-DOS® formatted 1.44-MB floppy disks 

For Windows 3.1x: Three blank MS-DOS® formatted 1.44-MB floppy disks

Minimum Software Requirements

o Microsoft® Windows™ 3.1, Windows for Workgroups™ 3.11, or Windows 95™
o FCC Mock Bidding System software (available through the Internet and the FCC Bulletin

Board System)
 o Netscape® Communicator™ 4.05

Note: If you are using the FCC Mock Bidding System for Windows 3.1x, you will
need to use Netscape Communicator 4.05 for Windows 3.1x.

Note: The FCC Mock Bidding System has not been tested in a Macintosh, OS/2, or Windows
NT™ environment.  Therefore, the FCC will not support operating systems other than Microsoft
Windows 3.1, Microsoft Windows for Workgroups 3.11, or Microsoft Windows 95.  This
includes any other emulated Windows environment.  If your Windows is in a networked
environment, you should check with your local network administrator for any potential conflicts
with the PPP (Point-to-Point Protocol) Dialer that is included with the FCC Mock Bidding
System for Windows 3.1x.  This usually includes any TCP/IP installed network protocol.  

Downloading the FCC Mock Bidding System

FCC Mock Auction participants must first download the FCC Mock Bidding System from either
the Internet or the FCC Bulletin Board System.  Participants must download the following
compressed files to install the software:

o For Windows 95:     mk95v43a.exe, mk95v43b.exe, mk95v43c.exe, mk95v43d.exe, 
      mk95v43e.exe

o For Windows 3.1x:  mk31v43a.exe, mk31v43b.exe, mk31v43c.exe

Download Method 1: Internet Access



15

You may use your Web browser to download the compressed files from wtbwww01.fcc.gov or
www.fcc.gov as described in the following section.

Downloading from wtbwww01.fcc.gov:

1. Connect to your Internet service provider and start your Web browser.

2. Enter the following location: http://wtbwww01.fcc.gov

3. Click on Mock

4. Click on Programs

5. Download the following files for Windows 95: mk95v43a.exe, mk95v43b.exe,
mk95v43c.exe, mk95v43d.exe, mk95v43e.exe 

Download the following files for Windows 3.1x: mk31v43a.exe, mk31v43b.exe,
mk31v43c.exe 

Downloading from www.fcc.gov:

1. Connect to your Internet service provider and start your Web browser.

2. Enter the following location: http://www.fcc.gov

3. Click on Auctions

4. In the Auctions section to the right, click on 220 MHz under Future.

5. Click on Mock Auction Software

6. Download the following files for Windows 95: mk95v43a.exe, mk95v43b.exe,
mk95v43c.exe, mk95v43d.exe, mk95v43e.exe 

Download the following files for Windows 3.1x: mk31v43a.exe, mk31v43b.exe,
mk31v43c.exe 

Download Method 2: Dial-In Access to the FCC Auction Bulletin Board
System (BBS):
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The FCC Auction Bulletin Board System (BBS) provides dial-in access for the FCC Mock
Bidding System.  To access the FCC Auction BBS, use a communications package that can
handle Xmodem or Zmodem protocol (such as PcAnyWhere, Procomm, or Microsoft Terminal in
Windows 3.1x or Hyperterminal in Windows 95) to dial in to (202) 682-5851. Use the settings of
8 data bits, no parity and 1 stop bit (8,N,1).

Once your computer is connected to the Auction BBS, do the following:

1. To create an account:

a. Enter your first name.

b. Enter your last name.

c. When asked whether you want to create an account, enter y (You may also enter
Y, the program accepts either case).

d. When prompted, enter a password.

The password can be from four to ten characters long (where the characters can
be either letters or numbers).

e. To confirm the password, enter it again.

f. When prompted for contact information, enter your voice phone number. 
Include the area code; for example, you might enter 202-555-1234.

g. Enter your company name.

2. On the Welcome screen, enter c for Continue. 

3. When asked whether you want to view the bulletin menu, enter y for Yes.  Then, to
continue, press ENTER to obtain the FCC Auction BBS Main Menu.

4. Enter a (for Auction Menu) to obtain the Auction Library Menu.  The top options on
this menu provide a range of numbers to represent the available auctions.

5. To select the Mock Auction, enter m. 

6. Enter p to select Programs.

The list of available files for the Mock Auction appears.  
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7. To scroll downward to the next screen of file names, either press ENTER or enter c for
Continue.  To scroll upward to the preceding screen of file names, enter p for
Previous.

Note that on each screen, file names are numbered separately, starting with 1.

8. To select one or more files for downloading, mark the files you want.  The program
marks a file by preceding its name with an asterisk (*).

You can do the following:

o To mark an individual file, enter its line number.  

o To mark a range of files, enter m (for Mark) and then enter the range of files in
response to the prompt. For example, to mark files 6 through 12, enter 6-12 at the
prompt.

o To unmark a file, enter its number again. You can also use Mark to unmark a range of
files.

Mark the following files for download:

For Windows 95: mk95v43a.exe, mk95v43b.exe, mk95v43c.exe, 
mk95v43d.exe, mk95v43e.exe 

For Windows 3.1: mk31v43a.exe, mk31v43b.exe, mk31v43c.exe

9. When you have finished marking files, you may download the marked files by taking the
following steps:

a. Enter d for Download.

The program displays a list that summarizes the download operation.  The Time
column lists the download time for each file; the Total Time column lists a running
total of the download times.

b. Enter d to proceed.

c. Select the file transfer protocol that has been specified in your terminal emulation
software (e.g.,  Zmodem).

d. When the download operation has finished, the list of files reappears.

10. Enter x to leave the BBS.
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Extracting the FCC Mock Bidding System

The FCC Mock Bidding System files are downloaded in a self-extracting, compressed file format. 
When you have downloaded all of the compressed files for the FCC Mock Bidding System, you
must extract the software from those files.

To extract the software, follow these steps:

1. Start File Manager or Windows Explorer and open the file folder where you downloaded
the files.

2. Double-click on mk95v43a.exe (for Windows 95) or mk31v43a.exe (for Windows 3.1x). 
A message will appear listing the default directory to which the software will extract.  If
this directory does not exist, it will be created automatically.

3. Click Unzip to begin extracting the software from the compressed file.

4. When the extraction is complete, a message appears listing the number of files that were
unzipped.  Click OK and repeat the above process for the remaining compressed files. 

Remaining files for Windows 95: mk95v43b.exe, mk95v43c.exe, mk95v43d.exe, and
mk95v43e.exe.

Remaining files for Windows 3.1x: mk31v43b.exe and mk31v43c.exe.

Be sure to extract to the same directory as the first compressed file.     

Installing the FCC Mock Bidding System

After you extract the software from the compressed files, you must install the FCC Mock Bidding
System.

Following are instructions for how to install the software:

1. Start File Manager or Windows Explorer and open the file folder to which you extracted
the software.

2. Double-click on setup.exe.

3. When the setup program begins, a screen appears listing the default directory to which the
software will install.  Click the Install button, then click OK to install to the specified
directory.  If the directory does not exist, the setup program will create it automatically.   
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4. A screen appears prompting you to enter the location of your Web browser.  Click the
Browse button to locate the browser executable or type the full path to the browser. 
Click OK to continue the installation.

5. If you are installing the FCC Mock Bidding System for Windows 95, the DOS System File
Modifications screen will appear. Click Save to allow the setup program to modify or
create the autoexec.bat file.

The DOS System File Modifications screen does not appear during the setup for the
Windows 3.1x version of the software.

6. When the installation is complete, a message may appear asking you to restart Windows
so that the changes made by the installation may take effect.  Click Restart to restart
Windows, or click Stay Here to restart at a later time.  Do not use the FCC Mock
Bidding System until you restart Windows.

7. After the FCC Mock Bidding System has been installed, you will have a new Program
group called FCC Mock Bidding System with the following icons: FCC Mock Bidding
System and Uninstall.  If you have Windows 3.1 or 3.11, the group will also contain icons
for Configure PPP and PPP Dialer.

Creating Backup Installation Disks for the FCC Mock Bidding System

You can create optional backup installation disks for the FCC Mock Bidding System after you
have extracted the software.  Open the file folder where you extracted the software and do the
following:

For Windows 95:        1. Copy setup.exe to disk 1
2. Copy setup.001 to disk 2
3. Copy setup.002 to disk 3
4. Copy setup.003 to disk 4
5. Copy setup.004 to disk 5

For Windows 3.1x: 1. Copy setup.exe to disk 1
2. Copy setup.001 to disk 2
3. Copy setup.002 to disk 3

Connecting to the FCC Network

Before using the FCC Mock Bidding System, you must first connect to the FCC Network.
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For instructions on how to connect using Windows 95, see the attachment entitled Accessing the
FCC Network Using Windows 95.

For instructions on how to connect using Windows 3.1x, see the attachment entitled Accessing
the FCC Network Using Windows 3.1x.

Using the FCC Mock Bidding System

Before running the FCC Mock Bidding System, you must connect to the FCC Network via the
FCC Auctions 800# or via the FCC Auctions 900# that you will use during Auction 18.

Note: If you connect to the FCC’s 900# telephone service, there is a charge of $2.30
per minute.  The first minute of connection time to the 900 number service is at no
charge. 

For Windows 95: After you have established a connection, you may start the FCC Mock
Bidding System by clicking the Start button, then select Programs and
FCC Mock Bidding System. Click on the FCC Mock Bidding System
icon.

For Windows 3.1x: After you have established a connection, you may start the FCC Mock
Bidding System by double-clicking the FCC Mock Bidding System icon
in the FCC Mock Bidding System program group. 

Important:  Disable any screen saver software before using the FCC Mock Bidding
System.

Uninstalling the FCC Mock Bidding System

To uninstall the FCC Mock Bidding System, double-click on the Uninstall icon in the FCC Mock
Bidding System program group.  Click Start to uninstall the software.

Help

For technical assistance with installing or using the FCC Mock Bidding System, contact the FCC
Technical Support Hotline at (202) 414-1250 (voice) or (202) 414-1255 (TTY).  The Hotline is
generally available Monday through Friday, from 8 a.m. to 6 p.m. ET.  All calls to the FCC
Technical Support Hotline are recorded. 
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Attachment F

ROUND RESULTS FILE FORMATS

This attachment describes the formats for the round results files that will be uploaded to the FCC
Internet site and FCC Auction Bulletin Board System (BBS) after each round of the auction.

This following layouts are for the dbf files.  The txt files will have character field types.

ALL_BIDS
market char(6)
freq_block char(2)
round_num numeric
bid_amt numeric
bidder_num numeric
fcc_acct char(10)
date date
time char(8)
net_bid_amt numeric
sort_col_1 numeric
sort_col_2 numeric

HIGH_BIDS
market char(6)
freq_block char(2)
bid_round_num numeric
bid_amt numeric
bidder_num numeric
fcc_acct char(10)
date date
time char(8)
net_bid_amt numeric
min_accept numeric
num_of_bids numeric
sort_col_1 numeric
sort_col_2 numeric

MAXIMUM_ELIGIBILITY
round_num numeric
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bidder_num numeric
fcc_acct char(10)
max_elig numeric
rmng_waivr numeric
waivr_ind char(1)
rmng_withdrawals numeric
required_act numeric

WITHDRAWALS
market char(6)
freq_block char(2)
bid_round_num numeric
bid_amt numeric
bidder_num numeric
fcc_acct char(10)
date date
time char(8)
net_bid_amt numeric
sort_col_1 numeric
sort_col_2 numeric

BIDDER_CROSS_REFERENCE
bidder_num numeric
fcc_acct char(10)
co_name char(50)
bidding_credit_pctg numeric

TRACKING THE FCC MOCK AUCTION

Mock Auction round results and announcement files will be posted on the FCC Internet and FCC
Auction Bulletin Board System (BBS) in the following locations:

Internet Site 1: http://wtbwww01.fcc.gov
 

1. Click on Mock.

2. Click on Results or Announcements.

FCC Auction BBS: Refer to Tab D (p.122) of the Bidder Information Package for how to
access the FCC Auction BBS.
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Select m for Mock Auction on the Auction Library Menu, then select r for 
Results or a for Announcements.

Mock Auction round results files and announcement files will be labeled under Auction 74.

Samples of Round Results files will also be posted to the Mock Auction directories on the FCC
Internet site and FCC Auction BBS with Auction 78.
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Attachment G

ACCESSING THE FCC NETWORK 
USING WINDOWS 95

This attachment describes how to access the FCC Network from a system that is running the
Microsoft Windows 95 operating system.  This involves configuring dial-up network access
and then performing the dial-up procedure.

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions
link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Location field, Selected Licenses
area of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions. 
For example, if you are instructed to type http://wtbwww01.fcc.gov, you should
type all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and
then press the ENTER key.

Configuring Dial-Up Network Access

1. To start dial-up networking:

a. Click the Windows 95 Start button.  
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. Click Dial-Up Networking.
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If Dial-Up Networking is not an option on your Accessories menu, you should install it
from your Windows 95 CD or diskettes.

2. When the Dial-Up Networking window appears, double-click the Make New
Connection icon.

3. The Make New Connection window appears. In the field titled Type a name for the
computer you are dialing:

Type FCC Auctions 800# if you wish to connect to the FCC Network during the
Mock Auction.

Type FCC Auctions 900# if you wish to test your connection on the 900# that will
be used during Auction 18.

4. Click the down arrow at the right of the Select a modem field and select your modem
from the menu of available modems.  

If your modem does not appear on this list, you must install your modem driver
according to the modem manufacturer installation procedures, which are usually
described in your modem’s user manual.

5. Click the Next button.  

6. If you wish to connect to the FCC Network during the Mock Auction, type 800 and
378-7435 in the Area Code and Telephone Number fields.

If you wish to test your connection on the 900# that will be used during Auction 18,
type 900 and 555-5335 in the Area Code and Telephone Number fields.

7. Verify that the correct country is selected in the Country code field.  

If necessary, click the down arrow at the right of the Country code field and select the
appropriate country from the menu of available countries.

8. Click the Next button.

9. Click the Finish button.  

An icon labeled either FCC Auctions 800# or FCC Auctions 900# appears in the Dial-
Up Networking window.
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10. Verify that properties are configured correctly before attempting a dial-up session.  Put
the mouse pointer on the FCC Auctions icon that you wish to configure and click the
right mouse button to display a menu.  Click Properties from the menu.

11. Click the Configure button.  Click the Options tab at the top of the Properties
window.

12. In the Connection control area of the Options tab, verify that neither option is selected. 
If either option is selected, click the check box at the left of the option to deselect it. 
Then click OK.

13. Click the Server Type... button. 
 
14. In the Advanced Options area, verify that only Enable software compression is selected. 

If it is not selected, click the check box at the left of the option to select it.  If either of
the other options is selected, click the check box to deselect it.

15. In the Allowed Network Protocols area, verify that only TCP/IP is selected.  

If it is not selected, click the check box at the left of the option to select it.  If either of
the other options is selected, click the check box to deselect it.

16. Click the TCP/IP Settings button and select Specify name server addresses.

17. Type 165.135.22.249 as the Primary DNS.  

18. Click OK on the TCP/IP Settings window, the Server Type window.

Dial-Up Procedure

1. If the Dial-Up Networking window is not currently open, do the following:

a. Click the Windows 95 Start button.  
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. Click Dial-Up Networking

  
The Dial-Up Networking window appears.  

2. In the Dial-Up Networking window:
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Double-click the FCC Auctions 800# icon if you wish to connect to the FCC Network
during the Mock Auction. 

Double-click the FCC Auctions 900# icon if you wish to test your connection to the
900# that will be used during Auction 18.

Note: If you connect to the FCC’s 900# telephone service, there is a charge of $2.30
per minute.  The first minute of connection time to the 900 number service is at no 
charge. 

3. Click the Connect button on the window.  Do not enter User name and Password.

The Connection window appears, indicating the status of your connection as your
modem dials into the FCC Network.  This window must remain running during your
dial-up session.  You may minimize the window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting section
below.

4. Once the connection is established, start the FCC Mock Bidding System.

5. When you have finished, exit the Web browser, then click the Disconnect button on
the Connection window to end your dial-up session.

Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating
them.

Modem does not respond

1. Confirm that all physical connections for the modem are present.

2. Confirm that the phone line is active by connecting it to a telephone.

3. If you are dialing the 900 number service, check for a 900 number telephone block. If
the volume settings are low, the modem may be dialing but not connecting. Check for
this by trying to connect to the 800 number, or by dialing the 900 number on that line
using a telephone. 

 
4. Confirm that the correct modem driver is installed for your modem. 
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Modem dials but does not connect

1. If you are dialing the 900 number service, check for a 900 number telephone block.
Check for this by dialing the 800 number to see if you connect, or by dialing the 900
number on that line using a telephone. 

2. Confirm that the number the modem is dialing is correct.

3. Confirm that the modem prefix, if any, is correct.

Modem dials and connects, but nothing appears when you enter the Location in the Web
browser  

1. If your Internet Service Provider adds numbers to the DNS Server Search Order list in
your Dial-Up Adapter’s TCP/IP protocol, you will need to add the FCC’s Primary DNS
number as well.  Do the following:

a. Click the Windows 95 Start button, then click the Settings option to display the
Settings menu. 

b. Click Control Panel and then double-click the Network icon. 

c. Highlight the TCP/IP Protocol and click Properties.  If there are multiple TCP/IP
protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties. 

d. Click the DNS Configuration tab. 

e. If Enable DNS is selected, type 165.135.22.249 in the DNS Server Search Order box
and click the Add button. 

f. Click OK on the TCP/IP Properties windows, then click OK on the Network windows. 

g. If you are prompted to restart your computer, click Yes to restart, then reconnect to
the FCC Network.

2. Verify the properties in your dial-up networking icon, particularly that the Primary
DNS is set to 165.135.22.249 and that TCP/IP is the only selected protocol.

3. Confirm that your Web browser is not using proxies.    

Receive an Internal Server error in the Web browser 
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1. Confirm that the Location is correct.

2. Confirm that JavaScript is enabled in your Web browser.

Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical
Support Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET. All
calls to the FCC Technical Support Hotline are recorded.
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Attachment H

ACCESSING THE FCC NETWORK
USING WINDOWS 3.1x

This attachment describes how to access the FCC Network from a system that is running the
Microsoft Windows 3.1x operating system.  This involves using the FCC-supplied Point-to-Point
Protocol (PPP) Dialer that is included with the FCC Mock Bidding System.  

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions
link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Location field, Selected Licenses
area of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions. 
For example, if you are instructed to type http://wtbwww01.fcc.gov, you should
type all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Configuring the FCC Dialer

Before establishing a connection, you must run the Configure PPP program.  If desired, you may
also adjust the configuration settings.

To start the Configure PPP program:

1. Double-click the Configure PPP icon.  The communications setup window appears.

2. From the Modem menu, select the COM port to which your modem is connected. 

3. From the Speed menu, select the maximum DTE rate of your modem.



31

For 14.4-kbps and 28.8-kbps modems, you can generally select a speed of 38400 or
57600. 

For U.S. Robotics modems, enter a speed of 19200.

4. In most cases, carrier detect should not be checked and flow control should be checked. 
If you experience problems getting the modem to respond, experimenting with these
settings may help.

5. The DNS should be set to 165.135.22.249.

The remainder of the screen has default values which should provide optimal performance.

6. Click the Script button to bring up the Script Setup screen.  This screen gives you the
ability to issue specific commands to the modem.

7. Click the down arrow in the Selected Modem field and choose the entry from the list that
most closely matches the modem installed on your PC.

If your modem does not appear in the list, select a generic modem string by entering either
ATZ (for 14.4-kbps modems) or AT&F (for 28.8-kbps modems) in the Reset Modem
String box.

8. It may be necessary to change the command in the Modem Dial Prefix field to
accommodate how you make calls. 

For example:

Add a 1 before dialing the 800 or 900 number: ATDT1
Dialing prefix of 9 used, add a 1 before dialing the 800 or 900 number: 

ATDT91
Turn off call waiting, add a 1 before dialing the 800 or 900 number: ATDT*70,1

9. If you use a dialing suffix, enter it in the Dial Suffix field.

10. The default settings provided in Configure PPP should be compatible with most systems. 
If you experience problems connecting to the FCC Network, refer to the Troubleshooting
section for possible solutions.

11. When you have finished using the Configure PPP program, click the OK button.  You
may now proceed to the Dial-Up Procedure section. 
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Dial-Up Procedure

Once you have run the Configure PPP program, you can establish a connection to the FCC
Network:

1. Double-click the PPP Dialer icon in the FCC Mock Bidding System program group. 

2. If you want to establish a connection for the Mock Auction, select Non-Toll (800 service). 

If you want to test your connection to the 900# that will be used during Auction 18, select
Toll call (900 service).

Note: If you connect to the FCC’s 900# telephone service, there is a charge of 
$2.30 per minute.  The first minute of connection time to the 900 number
service is at no charge. 

3. When the PPP Dialer establishes a connection, you will gain access to the PPP Dial Up
screen.  You may switch to the PPP Dial Up screen by pressing CTRL+ESC and
double-clicking PPP Dial Up in the Task List.

The screen will display the current status of the PPP connection.

If your modem fails to establish a connection, please see the Troubleshooting section
below.

4. Once the connection is established, start the FCC Mock Bidding System.

5. When you have finished, exit the Web browser, then switch to the PPP Dial Up screen and
select the Disconnect option from the Dial menu.

Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating them.

Modem does not respond

1. Check the COM port setting.
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2. Make sure that you have selected the appropriate modem in the Selected Modem list.  

If your modem does not appear in the list, select a generic modem string by entering either
ATZ (for 14.4-kbps modems) or AT&F (for 28.8-kbps modems) in the Reset Modem
String field.

3. Check your modem for IRQ conflicts.

4. Check the physical connections.

Modem connects but does not return an IP address

1. Check that you have selected the appropriate modem in the Selected Modem list.

2. Verify the DNS is set to 165.135.22.249.

3. Turn off VJ Compression.

4. Check your modem for IRQ conflicts.

5. Unload network drivers (disconnect from network).

SQLSERVER errors

1. Turn off VJ Compression.

2. Unload network drivers.

3. Check for the existence of multiple winsock.dll files on your PC.

4. Test the PPP connection with the Ping program.

Errors may be caused by having multiple winsock.dll files on your PC.  To search for conflicting
winsock.dll files, start File Manager, open the directory for the root of the hard drive you want to
search (usually c:\) and select the Search option from the File menu.  In the search for: box,
enter winsock.dll.  Verify that the select all subdirectories option is selected, then click OK.

Make sure that any other winsock files are not in your path.  To check this, go to the DOS
prompt and type path.  If any directory containing another winsock.dll file appears in the path, do
either of the following:
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C Temporarily rename the conflicting winsock.  

C Edit the autoexec.bat file to remove the reference to that directory, then save and cold
boot the PC.  If you need to use the other PPP software package, reinsert the appropriate
directory reference, save, and reboot.

Testing the PPP Connection

1. To test the status of your connection, select the Test Connection option from the Dial
menu on the PPP Dial Up screen.  This option allows you to ping the FCC Network.  The
ping process sends signals to the FCC Network; if the signals return, then you have
established a good connection.

If you are testing an 800# connection for the Mock Auction, enter sub_74.fcc.gov in the
Hostname box. 

If you are testing a 900# for Auction 18, enter sub_18.fcc.gov in the Hostname box. 

2. From the Number menu, choose the number of pings you wish to send (one, continuous,
or a user-specified number).  From the Specifications menu, you can customize the type
of request (e.g., icmp echo request), the interval between pings, and the timeout setting;
the default settings should suffice.  

If you change any of the settings and would like to save them, select the Save option from
the File menu.

3. Click the Start button.  

The status and packets boxes will display information concerning whether the pings were
returned.  

4. If necessary, click the Stop button, to end the ping process.  Click the Exit button to exit
the Ping program.

Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical
Support Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET. All
calls to the FCC Technical Support Hotline are recorded.
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